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Objectives 
 
As an instructor, you often need to review student writing projects and provide 
feedback to them. Instead of manually collecting or printing out those writing projects 
and adding your feedback, you can easily use Blackboard and Microsoft Word to collect, 
grade, and provide feedback to student writing projects electronically. Through this 
hands-on workshop, you will find out how these technology tools can make the process 
more efficient and less laborious. After this workshop, you should be able to:  
 

• Collect and grade student writing projects using Blackboard 
• Use Microsoft Word to provide electronic feedback 

o Use reviewing tools to add comments and track changes 
o Participate in a review that has multiple reviewers 
o Use color coding to indicate specific problems 
o Use a tablet pen to add ink annotations to a document 
o Choose different display and printing options 
o Create different versions of a document 
o Understand file naming conventions 
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Collect and Grade Student Writing Projects Using Blackboard 

Add an Assignment Drop Box 
Assignment drop boxes allow instructors to collect student writing projects and manage 
the grades and feedback for each student separately. Instructors may create an 
assignment drop box that lists the name, point value and description of the assignment; 
files may also be attached. After an assignment drop box is added to a Content Area, 
students may access and submit their files to the assignment drop box. Instructors can 
then view the students’ submissions through the Grade Center, enter grades and 
comments for individual student’s submissions, and attach feedback files if necessary. 
 
To create an assignment drop box, follow these steps: 

1. Log onto Blackboard and enter your course. 
2. Navigate to a Content Area where you wish to create the assignment, such as 

Course Documents, from the Course Menu. 

3. Choose Assignment from the Assessments menu on the menu bar.  

 

1. Complete the form on the Create Assignment page by entering the name of the 
assignment in the Name field. Optionally you can enter any specific assignment 
instructions into the Instructions field. Optionally you can click on the Browse 
My Computer button or the Browse Content Collection button to attach files.  

2. Enter the points possible into the Points Possible field under Grading. You can 
also associate rubrics to an assignment by clicking the Add Rubric Button to 
select a rubric.  
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3. To make the assignment available, select the checkbox. If you would like to 
choose date restrictions, select the Display After and the Display Until check 
boxes and select the dates. 

4. To track the number of views, select the checkbox in front of Track Number of 
Views.  

5. When your assignment is ready to be created scroll to the bottom of the page, 
click on the Submit button. 

 
When the students enter the course, they should select Course Documents from the 
Course Menu, and then click on the assignment name to enter the assignment drop box. 
On the Upload Assignment: Assignment Name page, the student can upload multiple 
files, enter comments, and submit their submissions to the instructor. The submissions 
will be imported into the Grade Center.  

 

 

Review and Grade Assignments 
Instructors can retrieve submissions for an assignment through the course Grade 
Center. Assignment submissions can be viewed and downloaded individually or all at 
once.  
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Retrieve and Grade a Single Student’s Submission  
1. Enter the Grade Center for the course by clicking Full Grade Center under the 

Grade Center subheading in the Control Panel.  

2. If a student has submitted something for an assignment, it will be indicated by a 
yellow exclamation mark (means Needs Grading), point your cursor to the cell 
that contains the yellow exclamation mark, and click the small downward arrow 
to the right of the cell and then select View Grade Details to enter the student’s 
submission.  

 
 

3. On the Grade Details page, click either the View Attempts or the Grade Attempt 
button to access and grade the student’s submission.  On this page, you also 
have the options to Clear Attempt, Ignore Attempt and Edit Grade.  
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4. On the next Grade Assignment: Assignment Name page, you will see the file 
that the student has submitted, read the student’s comments if any, download 
any file attachments, grade the attempt and enter Grader Feedback.  

 

 
 

5. Click Submit to save the changes.  

Download Multiple Students’ Submitted Files  
When using the Assignment tool, you can download multiple students’ submitted files 
for an assignment at one time. To download multiple files at one time:  

1. Enter the Grade Center for the course through the link in the Control Panel, 
make sure to click on Full Grade Center. 

2. Within the Grade Center, point your cursor to the name of the assignment that 
you want to download.  

Add 
Comments 

Download 
Files 

Attach 
feedback files 

Additional 
formatting options 

Grade attempt 
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3. Click the small downward arrow next to the assignment name, and then select 
Assignment File Download. 
 

 
The Grade Attempts function lets you enter in a grade for each student’s 
attempt at the assignment. 

4. On the Download Assignment: Assignment Name page, select the check boxes 
located to the left of the student names to download one, some, or all of the 
student’s submitted files for this assignment.  

 
5. Click the Submit button.  

6. Blackboard will create a .zip file containing all the submitted files. Click the link 
Download assignment now to download the zip file and save it to your 
computer. Each downloaded assignment entry will automatically include the 
student’s username.  
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Clear Students’ Assignment Attempts  

If students are allowed only one attempt at the assignment, once an assignment has 
been submitted, the student will not be able to resubmit the assignment. If the student 
needs to resubmit the assignment, you will need to clear the assignment attempt. 
Clearing the attempt will remove any comments and attachments that have already 
been submitted. Students will need to resubmit all comments and files.  

1. Enter the Grade Center for the course through the link in the Control Panel.  

2. Within the Grade Center, point your cursor to the name of the assignment.  

3. Click the small downward arrow next to the assignment name, and then select 
Clear Attempts for All Users. This will then clear all attempts so that students 
can reattempt the assignment. 

 
 

6. To clear only one student’s attempt, point your cursor to the cell of the student’s 
attempt, and click the small downward arrow to the right of the cell and then 
select View Grade Details to enter the student’s submission.  
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4. Click the Clear Attempt button on the Grade Details page and the student can 
resubmit their assignment. This feature also works for tests and surveys. 
 

 



 11 

Use M.S. Word to Provide Electronic Feedback 

Review Toolbar 
Click Review on the top menu of M.S. Word, the review toolbar will appear and it 
includes the tools you need to add comments as well as track changes you make in the 
document.  
 
 
 
 
 
 

 
 
 
 

 
Add/Edit/Delete Comments 
Add Comments 
To add a comment to the document:  

1. Highlight the text or item you want to comment on. 
2. Click on the New Comment icon on the reviewing toolbar, the Reviewing Pane 

will appear on the left side of the screen.         
3. Type your comment in the Reviewing Pane.  

 

 
 
 
Edit Comments 
To edit a comment:  

1. Open the Reviewing Pane by click on the Reviewing Pane icon on the Review 
Toolbar.  

2. Edit the text as needed. 

Insert 
Comment 

Accept 
Changes 

Reject 
Changes/Delete 

Comment 

Display for 
Review 

Track 
Changes 

Reviewing 
Pane 
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Delete Comments 
To delete a single comment: 

1. Select the comment you want to delete, you can use the Previous and Next 
buttons on the review toolbar to navigate to a specific comment.  

       
 
2. Click on the Reject icon on the review toolbar. 

 
 
To delete comments from specific reviewers:  

1. On the Reviewing Toolbar, click Show Markup >> Reviewers, and then click All 
Reviewers to deselect all the reviewers first.  

2. Click Show Markup >> Reviewers again, and then select the check boxes next to 
the names of the reviewers whose comments you want to delete. All the 
comments shown in the document are now made from those specific reviewers.  

3. On the Reviewing Toolbar, click on the small drop-down arrow under the Delete 
icon, and then select Delete All Comments Shown (Note: This option is grayed 
out when all reviewers are selected). This procedure will delete all comments 
from the reviewers you have selected.  

 
 

 
To delete all comments: on the Reviewing Toolbar, click on the small drop-down arrow 
under the Delete icon, and then select Delete All Comments in Document. This 
procedure will delete all the comments in the document no matter whether or not they 
are shown.  
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Alternatively, you can view, edit, and delete comments in the Reviewing Pane. Click on 
the Reviewing Pane icon on the Reviewing Toolbar to display or hide the Reviewing 
Pane.  

Note: the Reviewing Pane only displays comments that are shown in the document.  

Track Changes 
When you add comments or highlight text in a document, these markups will 
automatically show up. However, when you insert, delete, or format text or graphics, 
these changes will not show up in the document unless you track them:  

1. From the reviewing toolbar, click on the Track Changes icon. 

 
2. Make changes you want by inserting, deleting, moving, and formatting text or 

graphics. You will notice all the changes are marked up by different colors and 
formatting. Some markup elements are displayed in the text of the document, 
while others are displayed in balloons that appear in the margin.  

3. Click on Track Changes again to turn off change tracking. 

Accept/Reject Changes 
When you turn on the Track Changes feature, all the changes (insertions, deletions, or 
formatting changes) that you make are tracked and marked up. As you review these 
changes, you can choose to accept or reject a specific change or all changes.  
 
Accept Changes 
To accept a single change:  

1. Select the specific change you want to accept, you can use the Previous and 
Next icons on the Reviewing Toolbar to navigate to a specific change.  

             
 
2. Click on the Accept icon on the Reviewing toolbar (Alternatively, you can click on 

the small dropdown arrow under the Accept icon and select Accept and Move to 
Next, or you can right click on the specific change and select Accept 
Insertion/Deletion/Format Change from the pop-up menu).  
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To accept changes from specific reviewers:  
1. On the Reviewing toolbar, click Show Markup >> Reviewers, and then click All 

Reviewers to deselect all the reviewers first. 
2. Click Show Markup >> Reviewers again, and then select the check boxes next to 

the names of the reviewers whose changes you want to accept. All the changes 
shown in the document now are made from those specific reviewers.  

3. On the Reviewing Toolbar, click on the small dropdown arrow under the Accept 
icon, and then select Accept All Changes Shown (Note: This option is grayed out 
when all reviewers are selected). This procedure will accept all deletions, 
insertions, and format changes made by the reviewers you have selected. 
  

 
 

 
To accept all changes in document, on the Reviewing Toolbar, click on the small 
dropdown arrow under the Accept icon, and then select Accept All Changes in 
Document. This procedure will accept all changes in document no matter whether or 
not they are shown.   
 
Reject Changes 
To reject a single change:  

1. Select the specific change you want to accept, you can use the Previous and 
Next icons on the Reviewing Toolbar to navigate to a specific change.  

             
 

1. Click on the Reject icon on the Reviewing Toolbar (Alternatively, you can click on 
the small drop-down arrow under the Reject icon and select Reject and Move to 
Next, or you can right click on the specific change and select Reject 
Insertion/Deletion/Format Change from the pop-up menu).   
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To reject changes from specific reviewers:  

1. On the Reviewing toolbar, click Show Markup >> Reviewers, and then click All 
Reviewers to deselect all the reviewers first. 

2. Click Show Markup >> Reviewers again, and then select the check boxes next to 
the names of the reviewers whose changes you want to accept. All the changes 
shown in the document now are made from those specific reviewers.  

3. On the Reviewing Toolbar, click on the small dropdown arrow under the Reject 
icon, and then select Reject All Changes Shown (Note: This option is grayed out 
when all reviewers are selected). This procedure will accept all deletions, 
insertions, and format changes made by the reviewers you have selected. 
  

 
 
To reject all changes in document, on the Reviewing Toolbar, click on the small 
dropdown arrow under the Reject icon, and then select Reject All Changes in 
Document. This procedure will accept all changes in document no matter whether or 
not they are shown.   

 
Alternatively, you can accept and reject changes in the Reviewing Pane. Click on 
Reviewing Pane button on the Reviewing Toolbar to display or hide the Reviewing 
Pane, right click on the change you want to reject, and select Reject 
Insertion/Deletion/Format Change from the pop-up menu.  

Note: the Reviewing Pane only displays changes that are shown in the document. 

Add Ink Annotations 

If you are using a Tablet PC, you can use a tablet pen to make handwritten comments or 
annotate a document with handwriting.   
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Note: You must be running Microsoft Office Word 2003 on a Tablet PC in order to see all 
the tools described in this section and use this feature.  

To make handwritten comments:  

1. Select the text you want to comment on. 

2. On the Reviewing toolbar, click “Ink Comment” icon (Alternatively, you can 
select “Ink Comment” from the “Insert” pull-down menu).  

 

3. Write your comment in the comment balloon.  

 

To mark up the content of a document with handwriting:  

1. Select “Insert Ink Annotations” on the Reviewing toolbar (Alternatively, you can 
select “Insert Ink Annotations” from the “Insert” pull-down menu).  

 

2. Start write or draw anywhere on the document. 
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Note: it’s advised to use Print Layout when you insert ink annotations.  

Different Display Options 
 
You can select different display options on the Reviewing toolbar. By default, Word will 
display the final version of the document with markups shown. You can choose different 
display options by clicking on the small drop-down arrow next to the “Final Showing 
Markup” on the Reviewing toolbar. Here you can choose to show the final version of the 
document without the markups shown, the original version with markups shown, or the 
original version of the document. 
 

 
 
If you choose to have the markups shown (either “Final Showing Markup” or “Original 
Showing Markup”), you can choose to display specific changes you make to the 
document. Clicking on the “Show” icon on the Reviewing toolbar or click on the small 
drop-down arrow next to the icon, you will see different display options.   
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• Check/Uncheck “Comments”, “Ink Annotations”, “Insertions and Deletions”, or 
“Formatting” to display/hide these changes in the document.  

• Select which reviewers’ changes to display/hide by click on “Reviewers” and then 
check or uncheck the checkboxes next to the reviewers’ names. 

• Click “Balloons” then select the way that you want the balloons to be displayed. 
Three options available: “Always,” “Never” and “Only for Comments/ 
Formatting.” 

o “Always” option: deletions, comments and formatting changes will be 
displayed in the body of the text as well as in balloons in the page margin. 
Insertions will still be displayed in the body of the text.  

o “Never” option:  All insertions, deletions, formatting and comments will 
be displayed in the body of the text.  

o “Only for Comments/Formatting” option: both insertions and deletions 
will be displayed in the body of the text, while comments and formatting 
changes will be displayed in the body of the text as well as in balloons.  

• Select/deselect “Reviewing Pane” to show and hide the “Reviewing Pane” at the 
bottom of the screen.  

• Click “Options” to change the way tracked changes and comments look. When 
you click on “Options,” the “Track Changes” window will open.  
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To change the format of the markups, under Markup: 

• Click the drop-down arrow next to the type of change (Insertions, Deletions, 
Formatting, or Changed lines) and specify the format that Word will use for each 
type of change. For instance, you can have Word display Insertions as “Color 
only” instead of “Underline.”  

• Click the drop-down arrow next to the color to change a color Word uses to 
indicate the specific type of change. Note: By default, Word uses a different 
color for each reviewer.  

To change display options for the balloons:  

• Click on the drop-down arrow next to the “Use Balloons (Print and Web Layout)” 
and select the way that you want the balloons to be displayed. See above.  

• Adjust the values in the “Preferred width,” “Margin,” and “Measure in” boxes to 
change the layout and margin width for the balloons.  

To change the printing options for the balloons, under “Printing (with Balloons),” choose 
from the three options for “Paper orientation” 

• “Auto” option: Word will decide the paper orientation to provide the best 
document layout.  
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• “Preserve” option: to print the document with paper orientation specified in the 
“Page Setup” under the “File” pull-down menu (for instance, if “Portrait” is 
selected in “Page Setup,” then your document will be printed with portrait 
orientation. 

• “Force Landscape” option: to print the document with landscape orientation. 
This option will allow the most room for the balloons.  

Different Printing Options 

You can choose to print document with markups shown:  

1. Select “Print” from the “File” pull-down menu. 

2. Click the small drop-down arrow next to “Print what,” and select “Document 
showing markup.”  You can also choose to print just a list of markup.  

 

Create Different Versions of a Document  
You can save multiple versions of a document within the document itself at many stages 
of its evolution. Microsoft Word will save only the differences between versions, not an 
entire copy of each version, therefore, you can save disk space. Later, you can go back 
and review, open, print or delete earlier versions. It is different from the “Save as” 
option which saves the entire copy of the document as a separate file. There are some 
situations when you want to save a version of a document. For example, you might 
want to save a version when you or the student makes changes to the document and 
make a note on what changes are made, who made those changes and when.  
 

1. Select “Versions” from the “File” pull-down menu.  
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2. Form the pop-up window, you can check the checkbox “Automatically save a 

version on close” to automatically save a version of the document whenever you 
close it. The “Comments” for this version will be automatically entered as 
“Automatic Version.”  Click “Save Now…” to save a version manually.  

 

 

 

3. From the “Save Version” window, enter your comments on this version you are 
saving. Then click on “OK.” 
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4. You can click on “Version” from the “File” pull-down menu again to open or delete 

previous versions. 
 

 
 

Alternatively, you can double click the “Versions” icon at the bottom of the WORD 
screen to access previous versions.  
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File Naming Conventions 
 
Each semester, you may receive many files from students. Therefore, it is especially 
important for both you and your students to establish file naming conventions. 
 
You can assign numbers to your writing projects, and ask the students to name their 
files as “A#_Lastname” (A# represents assignment number), for example, “A1_Zhu.” If 
they will submit several versions of the assignment, ask them to add version number 
(V#) following the assignment number, for example, “A1(V2)_Zhu” (Note: ask them to 
add first name is there is someone else in the class who shares the same last name). 
 
After you make comments and changes to the file submitted by the students, you can 
save it either as a separate file (using the “Save as…” option under the “File” pull-down 
menu) or save it as a new version (using the “Versions” option under the “File” pull-
down menu), and name it as “A#_Lastname_YourInitialsComments,” for example, 
“A1_Zhu_BGComments.” For version 2, name it as “A1(V2)_Zhu_BGComments,” so on 
and so forth. If you save the file as a new version, you can enter the name in the 
“Comments on version” dialogue box.   
 
You can come up with your own file naming conventions as long as it’s easy for you to 
manage the many files and versions.  
 
 

       


	Objectives
	Table of Contents
	Collect and Grade Student Writing Projects Using Blackboard
	Add an Assignment Drop Box
	Review and Grade Assignments
	Retrieve and Grade a Single Student’s Submission
	Download Multiple Students’ Submitted Files

	Clear Students’ Assignment Attempts

	Use M.S. Word to Provide Electronic Feedback
	Review Toolbar
	Add/Edit/Delete Comments
	Track Changes
	Accept/Reject Changes
	Add Ink Annotations
	Different Display Options
	Different Printing Options
	Create Different Versions of a Document
	File Naming Conventions


